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Oracle welcomes customers' comments and suggestions on the quality and usefulness 
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Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example:

■ Are the implementation steps correct and complete?

■ Did you understand the context of the procedures?

■ Did you find any errors in the information?

■ Does the structure of the information help you with your tasks?
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■ Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell 
us your name, the name of the company who has licensed our products, the title and 
part number of the documentation and the chapter, section, and page number (if 
available).

Note: Before sending us your comments, you might like to check 
that you have the latest version of the document and if any concerns 
are already addressed. To do this, access the Online Documentation 
available on the Oracle Technology Network Web site. It contains the 
most current Documentation Library plus all documents revised or 
released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number 
(optional).

If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services. 

If you require training or instruction in using Oracle software, then please contact your 
Oracle local office and inquire about our Oracle University offerings. A list of Oracle 
offices is available on our Web site at http://www.oracle.com.
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Preface

This guide describes the administration tasks for Oracle Retail Advanced Science 
Cloud Services.

Audience
This guide is intended for administrators.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
For more information, see the following documents in the Oracle Retail Advanced 
Science Cloud Services documentation set:

■ Oracle Retail Advanced Science Cloud Services User Guide

■ Oracle Retail Advanced Science Cloud Services Implementation Guide

■ Oracle Retail Advanced Science Cloud Services Release Notes 

■ Oracle Retail Insights Cloud Service Suite/Oracle Retail Advanced Science Cloud Services 
Data Interface

Customer Support
To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

■ Product version and program/module name



x

■ Functional and technical description of the problem (include business impact)

■ Detailed step-by-step instructions to re-create

■ Exact error message received

■ Screen shots of each step you take

Improved Process for Oracle Retail Documentation Corrections
To more quickly address critical corrections to Oracle Retail documentation content, 
Oracle Retail documentation may be republished whenever a critical correction is 
needed. For critical corrections, the republication of an Oracle Retail document may at 
times not be attached to a numbered software release; instead, the Oracle Retail 
document will simply be replaced on the Oracle Technology Network Web site, or, in 
the case of Data Models, to the applicable My Oracle Support Documentation 
container where they reside.

Oracle Retail documentation is available on the Oracle Technology Network at the 
following URL:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

An updated version of the applicable Oracle Retail document is indicated by Oracle 
part number, as well as print date (month and year). An updated version uses the 
same part number, with a higher-numbered suffix. For example, part number 
E123456-02 is an updated version of a document with part number E123456-01.

If a more recent version of a document is available, that version supersedes all 
previous versions.

Oracle Retail Documentation on the Oracle Technology Network
Oracle Retail product documentation is available on the following web site:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

(Data Model documents are not available through Oracle Technology Network. You 
can obtain these documents through My Oracle Support.)

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
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1Administrative Tasks 

This chapter describes the processes for maintaining users and roles as well as batch 
processes. For information regarding standard end user activities like creating and 
viewing reports, please see the Oracle Retail Advanced Science Cloud Services User Guide.

Oracle Support
It is considered to be a best practice to have all Oracle Retail Advanced Science Cloud 
Services support requests submitted through a single point of contact for that 
customer environment; the client designated administrator is usually designated to 
perform this role. 

The link to use when submitting Service Requests (SR) is:

https://support.oracle.com

User Creation
Before users can access the Oracle Retail Advanced Science Cloud Services 
applications it is necessary to provision each user access to the system, and assign roles 
to each user to control what functionality will be available to them. The access 
provisioning is done using Oracle Identity Management (OIM). The following steps 
explain how to define users, assign roles and revoke access for users when needed. 
The OIM Application URL and the login with the required administrator access would 
be needed to execute the below steps:

1. Log into the OIM application.

2. Under Administration, click Users.
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Figure 1–1 Select Users

3. Under Actions, click Create.

Figure 1–2 Select Create

The Create User screen appears.

4. Under Basic Information, enter the following:

■ First Name

■ Last Name

■ For Organization, enter Retail

■ For User Type, enter Full time employee

■ E-mail: Email address of the employee

5. Under Account Settings, enter:

■ User Login: <firstname>.<lastname>

■ Password:

■ Confirm Password
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Figure 1–3 Complete User Information

6. Click Submit.

Assigning Members to a Role
To assign members to a role, complete the following:

1. Log into the OIM application. 

2. Click Users.

Figure 1–4 Select Users

3. Click the oim.test user.
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Figure 1–5 oim.test User

4. Click the Roles tab.

Figure 1–6 Roles Tab

5. Click the Request Roles button.

Figure 1–7 Request Roles Button

6. Click the Add to Cart button next to the role you want to assign.
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Figure 1–8 Adding Roles to the Cart

7. Click Next.

Figure 1–9 Add Access Request

8. Click Submit.

Figure 1–10 Submit Access Request

The role is now assigned to the User.
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Figure 1–11 User Details

Oracle Retail Advanced Science Cloud Services Default Enterprise Roles
Oracle Retail Advanced Science Cloud Services is built with role-based access. 
Permissions are associated with roles.

The following roles are available:

Table 1–1  Retail Advanced Science Cloud Services Default Enterprise Roles

Application Module Default Enterprise Roles
Corresponding Application 
Roles Display Name

ORASE 
Administration

CONFIG_ADMINISTRATOR_JOB Configuration Administrator 
Duty

INTEGRATION_ADMINISTRATOR_
JOB

Integration Administrator 
Duty

ORASE 
Administration - 
Science Innovation 
Workbench

DATA_SCIENCE_REST_SERVICE Retailer Workspace RESTful 
Service Duty

DATA_SCIENCE_ANALYST Data Science Analyst Duty

DATA_SCIENCE_
ADMINISTRATOR

Data Science Advanced Duty

DATA_SCIENCE_ORCL_ADMIN Data Science Oracle Admin 
Duty

Customer Decision 
Tree

ANALYTIC_EXPERT_JOB Customer Decision Tree Duty

Demand 
Transference

ANALYTIC_EXPERT_JOB Demand Transference Duty
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Assign the above roles to the user following the steps mentioned in the previous 
section as per your requirement. 

Assortment and 
Space Optimization

CATEGORY_MANAGER_JOB Category Manager Duty

SPACE_PLANNER_JOB Micro Space Optimization 
Analyst Duty

MERCHANDISING_ANALYST_JOB

SPACE_ADMINISTRATOR_JOB ASO Administrator Duty

FORECAST_MANAGER_JOB Analytic Super User Duty

Advanced 
Clustering

ASSORTMENT_PLANNER_JOB Advanced Clustering Business 
Duty

MERCHANDISER_JOB

CLUSTERING_ADMINISTRATOR_
JOB

Advanced Clustering 
Advanced Duty

Customer 
Segmentation

ASSORTMENT_PLANNER_JOB Customer Segmentation 
Business Duty

MERCHANDISER_JOB

MARKET_ANALYST_JOB

CUSTOMER_ANALYST_JOB

CUSTOMER_SEGMENT_ 
ADMINISTRATOR_JOB

Customer Segmentation 
Advanced Duty

Attribute Binning ATTRIBUTE_BINNING_JOB Attribute Binning Duty

Social Analytics SOCIAL_ANALYTICS_JOB Social Analytics Duty

Attribute Extraction ATTRIBUTE_EXTRACTION_JOB Attribute Extraction Duty

Return Logistics RETURN_LOGISTICS_JOB Return Logistics Duty

Retail Home RETAIL_HOME_ADMIN

Pricing PRICING_ADMINISTRATOR_JOB Pricing Administrator Duty

PRICING_MANAGER_JOB Pricing Super User Duty

PRICING_ANALYST_JOB Pricing Analyst Duty

OO_BUYER_JOB Buyer Duty

Hospitality HOS_FORECAST_ANALYST Hospitality Forecast Analyst 
Duty

HOS_FORECAST_CORPORATE_
ANALYST

Hospitality Forecast Corporate 
Analyst Duty

HOS_FORECAST_STORE_
MANAGER

Hospitality Forecast Store 
Manager Duty

Menu 
Recommendation

MENU_RECOMMENDATION_JOB Menu Recommendation Duty

ORAAC INSIGHT_APPLICATION_
ADMINISTRATOR_JOB

ADMIN_CONSOLE_
WITHOUT_SECURITY_DUTY

Table 1–1 (Cont.) Retail Advanced Science Cloud Services Default Enterprise Roles

Application Module Default Enterprise Roles
Corresponding Application 
Roles Display Name
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Revoking Role Membership
To revoke the membership of a member in a role:

1. Log into the OIM application.

2. Click Users. 

Figure 1–12 Select Users

3. Click the oim.test user.

Figure 1–13 Select Role to Revoke Users

4. Click the Roles tab.



Oracle Support

Administrative Tasks 1-9

Figure 1–14 Roles Tab

5. Select the Role you want to revoke and click the Remove Role button.

Figure 1–15 Remove Roles Button

6. In the Remove Roles screen, click Submit.

Figure 1–16 Remove Roles Screen

Deleting a User or Disabling User Privileges
To delete or disable a user

1. Log into the OIM application.

2. Under Administration, click Users.
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Figure 1–17 Select Users

3. Select the user and click Disable or Delete as necessary. 

Figure 1–18 Delete and Disable

4. You can also Lock or Unlock a particular user from the same screen if needed.

Resetting a User Password
To reset the password of a user:

1. Log into the OIM application.

2. Under Administration, click Users.
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Figure 1–19 Select Users

3.  Click the Search tab and then select on the User you want to reset the password.

4. Click on Reset Password.

Figure 1–20 Reset Password Button

5. In the Reset Password screen, make sure Auto-generate the Password is selected 
and Click on Reset Password. (The system will auto generate the password and 
will email it to the user.) 
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Figure 1–21 Reset Password

Approve Requests from User
The users can also request for the Roles or revoke those that are available for him to 
access the ORASE Service. Below are the steps to approve the request from the User.

1. Login into OIM Application.

2. Click Pending Approvals.

Figure 1–22 Select Pending Approvals

3. Click on the Action that is assigned to you.
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Figure 1–23 Pending Approvals Tab

4. Click the Claim button.

Figure 1–24 Claim the Pending Approval

5. Click Approve or Reject.

Figure 1–25 Approve Pending Approval

6. Once done the request is completed.

Approve Requests from User for Multiple Roles
The users can also request for the multiple Roles or revoke them if they are available 
for him to access the ORASE Service. Below are the steps to approve the request from 
the User.

1. Login into OIM Application.

2. Click Pending Approvals.
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Figure 1–26 Select Pending Approvals

3. Click on the Action that is assigned to you.

Figure 1–27 Pending Approvals Tab

4. Click the Claim button.

Figure 1–28 Claim the Pending Approval

5. Click Approve or Reject.
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Figure 1–29 Approve Pending Approval

6. Once done, if approved, the request is split into multiple requests, one for each 
role for each user. Approve all of them by following steps 3 to 5. 

7. Once all the requests are approved, all the roles will be assigned to users.

Note: The customer administrator can request multiple roles for 
multiple users. Once this request is made, the customer administrator 
is required to approve the request using the Approve Requests from 
User for Multiple Roles process.

Importing a Batch of User Accounts
If you have batch of users that have to be created, the Oracle team can bulk load the 
users into the OIM Application. When users are bulk loaded their initial password will 
be set to the current password of a template user. The new users will be required to 
change their password on first login. 

To request the creation of accounts by bulk loading, follow the below steps.

1. Create CSV file listing all users to create (see example below).

2. Create or identify a user to whose password will be used as the initial password 
for all created users.

3. Open an SR with Oracle support and provide the CSV file and user from steps 1 
and 2.

##################
 filename.csv
###################
##########################################
USR_LOGIN,USR_FIRST_NAME,USR_LAST_NAME,USR_EMAIL,ORG_NAME
ce.admin1,ce,admin1,ce.admin1@oracle.com,Retail
ce.admin2,ce,admin2,ce.admin2@oracle.com,Retail
ce.admin3,ce,admin3,ce.admin3@oracle.com,Retail
ce.admin4,ce,admin4,ce.admin4@oracle.com,Retail
ce.admin5,ce,admin5,ce.admin5@oracle.com,Retail
ce.admin6,ce,admin6,ce.admin6@oracle.com,Retail
ce.admin7,ce,admin7,ce.admin7@oracle.com,Retail
ce.admin8,ce,admin8,ce.admin8@oracle.com,Retail
ce.admin9,ce,admin9,ce.admin9@oracle.com,Retail
ce.admin10,ce,admin10,ce.admin10@oracle.com,Retail
##########################################
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Bulk Role Membership Update (Optional)
If you have quite a few users that have roles to be assigned to, the Oracle team can 
bulk update the role membership into the OIM Application.   

To update the membership of the by bulk update, follow the below steps.

1. Create CSV file with the user role mapping. Please note that the user name must 
be in upper case (see example below).

2. Open an SR with Oracle support and provide the CSV file and user from steps 1.

##################
 role.csv
###################
##########################################
UGP_NAME,USR_LOGIN
Role1,CE.ADMIN1
Role2,CE.ADMIN1
Role1,CE.ADMIN2
Role3,CE.ADMIN3
Role4,CE.ADMIN4
Role5,CE.ADMIN5
Role6,CE.ADMIN6
Role7,CE.ADMIN7
Role8,CE.ADMIN8
Role2,CE.ADMIN8
Role2,CE.ADMIN9
##########################################

Note: If you want more than one role attached to a particular user, 
add one more row with the role that you want the user to have and 
the user name. Refer to the CE.ADMIN1 in above table for example.

Nightly Batch File Uploads
The following is the file upload process. For details regarding file contents and 
formatting please refer to the Oracle Retail Advanced Science Cloud Services Integration 
Guide. The Private/Public Keys must be generated and the public Key must be 
associated with your SFTP Account for the file uploads. The Adding Authorized Keys 
section describes the step-by-step method to generate the Keys (2048 bit RSA Keys).

Adding Authorized Keys
The following is the process to generate a 2048 bit RSA key and add the same to the 
SFTP server. This is done with the help of WinSCP tool on Windows. However the 
same can be done using ssh-keygen on Linux as well.

1. Launch WinSCP and select Tools -> Run PuttyGen.

2. Select "SSH-2 RSA" for the type of key to generate and enter "2048" for the number 
of bits in a generated key field and click Generate.
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Figure 1–30 Key Generator

3. Move the mouse over the blank space in the window until the key is generated.

Figure 1–31 Key Generator Progress
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4. Once the key is generated, click the Save public key button to save the public key 
to a file.

5. Click the Save private key button to save the Private key to a file. Confirm to save 
it with/without a passphrase.

6. Open an SR with Oracle Support, to associate the Public half of the Key with your 
SFTP account (attach the Key with the SR).

Steps – Login to WinSCP
The Upload steps uses the private key generated in the earlier section.

1. Launch WinSCP and connect to <SFTP Server> using port 22. 

2. Enter the username and click Advanced.

3. Click Authentication. 

4. In the Private Key File field, click the Browse button and select the private key 
created in the earlier section.

Figure 1–32 Advanced Site Settings Dialog

5. After loading the private key file, click OK.
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Figure 1–33 Private Key File Loaded

6. Click Login. The window does not prompt for a password and logs into the SFTP 
server. Provide a passphrase if one has been set up.

Steps to Upload the Batch File
Login to the WinSCP by Following the Steps – Login to WinSCP section.

1. Transfer all data files to the directory /<SFTP User>.

2. Create a directory called COMMAND under /<SFTP User>if it does not already 
exist.

3. Change to the /<SFTP User>/COMMAND directory.

4. Transfer an empty file called COMPLETE.

Export File Downloads
Login to the WinSCP by following the Steps – Login to WinSCP section. The following 
is the download file process.

1. Change directory to /<SFTP User>/EXPORT.

2. Download all data files.
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2Science Innovation Workbench 

Science Innovation Workbench is a retailer workspace that provides read-only access 
to ORASE cleansed data. This extension is a workspace for advanced analytics users to 
add a new implementation using Oracle Advanced Analytic (Oracle R/ODM) 
algorithms that are implemented as SQL/PLSQL functions. This chapter provides the 
steps to configure the retailer workspace for the retailer in a cloud environment.

Workspace
A workspace <RETAILER_WORKSPACE> is predefined for the retailer and is where 
workspace users can create database objects and applications. The workspace has the 
privilege to the allocated <RETAILER_WORKSPACE_SCHEMA> database schema.

Users and Roles
Science Innovation Workbench has two types of users, application developers and 
workspace administrators, using Application Express. As a workspace administrator, 
you can create and edit developer accounts, manage groups, and manage 
development services. Before you create a developer for the science innovation 
workbench, you must create a user in Oracle Identity Management with the same 
credentials.

Science Innovation Workbench Developer
As a workspace administrator, you create a workbench developer by selecting Manage 
Users and Groups, as shown in Figure 2–1. Developers can create and modify 
applications and database objects in the allocated workspace and schema. Developers 
have privileges required by Oracle Data Mining and Oracle R Enterprise for executing 
analytic models. Complete the following steps to accomplish these tasks.
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Figure 2–1 Manage Users and Groups

1. Use the Oracle APEX Create User screen shown in Figure 2–2 to create a new 
developer account and to assign a RESTful Service group.

Figure 2–2 Create User

Note that this user must also be created in Identity Management with the same 
username/password.

2. Assign the new developer account to a RESTful Service group, as shown in 
Figure 2–3.

Figure 2–3 RESTful Service Group
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3. Set Require Change of Password on First Use to No.

Figure 2–4 Require Change of Password on First Use
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3Retail Home 

Retail Home is a portal-type application for the RGBU enterprise. The UI consists of a 
tile-based configurable dashboard that highlights important metrics and KPIs across 
RGBU applications.The persona-based dashboards are configured by a Retail Home 
administrator for each enterprise role. 

Application Configuration
The application links available in Retail Home are launched from dashboard tiles. To 
configure these links, complete the following steps:

1. Select Manage Application Navigator from the task menu. The Application List is 
displayed. If no application have been added, the list will be empty.

Figure 3–1 Application List

2. To add an application to the list, click the Add icon in the Application List. The 
following dialog box is displayed.
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Figure 3–2 Add Application Info

3. Provide the following information in the fields of the Add Application Info dialog 
box:

■ Application Name. The name entered is used to the tile header and for the 
application name in the Navigator.

■ Color Set. The color selected is used in the tile header and background color. 
The color sets are pre-defined.

■ Application Code. Select from the drop-down list. This field is optional.

■ Application Link. The link is used to launch the application from the tile 
header. This field is optional.

■ ORAAC Link. If a link is provided, then all the tasks associated with the 
application in question are displayed in the administration group of the 
Settings menu. This field is optional.

4. After adding an application, click OK to finish adding or click OK and Create 
Another to add another application.

5. To edit an existing Application Info record, click the Edit icon in the Application 
List. The following dialog box is displayed.
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Figure 3–3 Edit Application Info

6. Make changes as necessary to any of the fields described in step 3. Click OK when 
finished.

7. To delete an application from the Application List, select the application name and 
click the Delete icon.

8. Use the Up arrow and the Down arrow to change the order of the applications in 
the Application List.

Figure 3–4 Configured Application Navigator

Role Configuration
This section describes the process for associating enterprise roles with application tiles. 
Prior to assigning roles, you must first configure the dashboard to display the 
applications.

For more information about roles, see Oracle Retail Advanced Science Cloud Services 
Implementation Guide and Oracle Retail Advanced Science Cloud Services Administration 
Guide.
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Adding a Role
To add a role, complete the following steps:

1. From Role/Tile Configuration, select Mapping Table for Role and Application 
Tiles.

Figure 3–5 Mapping Table for Role and Application Tiles

2. Click the Add icon. The Add Role dialog box is displayed.

Figure 3–6 Add Role
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3. Enter text in the Role Name text box to search for a specific role. If the result 
include more than one role, select the appropriate one.

4. Select the application tile or tiles to associate with the role name you selected in 
step 2.

5. Select the Displayed check box as appropriate.

6. Select the tile size: 1 x 1 or 2 x 2. These are the only two options available.

7. Click OK to save your changes and close the dialog box. Click OK and Add 
Another to save your changes and map roles to applications. Click Cancel to close 
the dialog box without saving your changes.

Duplicating a Role Configuration
To duplicate an existing association between a role and an application, complete the 
following steps: 

1. From Role/Tile Configuration, select Mapping Table for Role and Application 
Tiles.

Figure 3–7 Mapping Table for Role and Application Tiles

2. Click the Duplicate icon. The Duplicate Role Configuration dialog box is 
displayed.

Figure 3–8 Duplicate Role Configuration



Role Configuration

3-6 Oracle Retail Advanced Science Cloud Services Administration Guide

3. Enter text in the Duplicate to Role text box to search for a specific role. If the result 
include more than one role, select the appropriate one.

4. Click OK to save your changes and close the dialog box. Click OK and Duplicate 
Another to save your changes and add another role. Click Cancel to close the 
dialog box without saving your changes.

Editing a Role
You can change the order of the application tiles, toggle the display, and adjust the size 
of a tile.

To edit an existing role, complete the following steps.

1. From Role/Tile Configuration, select Mapping Table for Role and Application 
Tiles.

Figure 3–9 Mapping Table for Role and Application Tiles

2. Click the Edit icon. The Edit Role dialog box is displayed.
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Figure 3–10 Edit Role

3. To change the order of application tiles, drag and drop the icon and click OK.

4. To toggle the display of applications, adjust the check marks and click OK.

5. To adjust the size of a tile, select an alternative size from the drop-down list and 
click OK.

Deleting a Role
You can delete a role association record along with its associated tile and contextual 
details.

To delete a role, select that role and click OK.

Figure 3–11 Delete Role Confirmation

Tile Configuration
Retail Home displays application tiles within the dashboard. You can configure 
application tile states and the data sources used for the metrics displayed in the tiles. 
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Buyer Role, Merchandising Tile States, shown in Figure 3–12, contains the following 
fields.

■ Displayed. A check box that toggles between two states, displayed and not 
displayed.

Tile State Report. This field is mandatory and is used to indicate the report that is 
displayed in the tile state. 

The default report names that come with Retail Home include Company Website, 
Insights: Sales vs. Returns, Insights: Returns, Insights: Purchase/Returns, 
Assortment Plan: Pending Orders, Customer: Loyalty Planned vs. Actual Sales, 
Financial Planning: Plan vs. Last Year Values, Price Management: Total 
Markdowns (Regular, Clearance, and Promotions), Science: Activity, Science: 
Trending, Science: Sentiment, Allocation: Incoming Order Status, Allocation: 
Planned vs. Actual, Merchandise: Order Quantities, Merchandise: On Order vs. 
Pending Approval, Favorites, Notification.

■ Expanded Report. This field is optional. Values include None (default).

■ Active. A check box that toggles between two states, active and inactive. Only one 
data source for a tile state can be active at a time.

■ Name. The name of the data source.

■ Type. The data type, either REST or FILE.

■ Source. The URL for the source of the data.

Adding a Tile State
To add a tile state, complete the following steps:

1. From Role/Tile Configuration, select a combination of role and application. 

Figure 3–12 Buyer Role, Merchandising Tile States

2. Select a combination of role and application from the drop-down list.

Note that only five tile states can be displayed for a given role/application.

3. Click the Add icon. The Add Tile State dialog box is displayed.
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Figure 3–13 Add Tile State

4. Select the Displayed check box to toggle to the displayed state.

5. Select the Tile State Report from the drop-down list.

6. Select the Expanded Report from the drop-down list.

7. Click OK to save your changes and close the dialog box. Click OK and Duplicate 
Another to save your changes and add another tile state. Click Cancel to close the 
dialog box without saving your changes.

Editing a Tile State
To edit the tile state, make the necessary changes to the dialog box shown in 
Figure 3–14, and click OK.

Figure 3–14 Edit Tile State

Deleting a Tile State
To delete a tile state and its associated data sources, select the one you want to delete 
and click OK.
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Figure 3–15 Delete Tile State

Moving a Tile State
To move a tile state within the list, highlight the tile state you want and use the Up 
arrow and the Down arrow to adjust the position as required.

Figure 3–16 Move Tile State

Adding a Data Source
To add a data source, complete the following steps:

1. From Role/Tile Configuration, select a combination of role and application. 
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Figure 3–17 Adding Data Source

2. Select a combination of role and application from the drop-down menus.

Note that only five tile states can be displayed for a given role/application.

3. Select the Tile State Report that you want to add a data source for.

4. Under Data Sources for <name of Tile State Report>, click the Add icon.

Figure 3–18 Add Data Source

5. Select the Active check box to toggle to the active state.

If another data source is active, you will be asked to change the active data source. 
Click OK to make the new data source active.
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Figure 3–19 Change Active Data Source

6. Select the Data Source Name from the drop-down list.

7. Select the Data Type from the drop-down list.

8. Enter a valid URL for the data source. Note that the URL will be validated and you 
will receive an error message if the URL is not valid.

9. Click OK to save your changes and close the dialog box. Click OK and Duplicate 
Another to save your changes and add another data source. Click Cancel to close 
the dialog box without saving your changes.

Editing a Data Source
To edit the data source, make the necessary changes to the fields shown in Figure 3–20 
and click OK.

Figure 3–20 Edit Data Source

Deleting a Data Source
To delete a data source, select the one you want to delete and click OK.
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Figure 3–21 Delete Data Source Confirmation

Duplicating a Tile Configuration
You can duplicate all of the tile states and data sources from the displayed 
role/application intersection to another role.

Click OK to duplicate the tile configuration. Click OK and Duplicate Another to 
duplicate more than one tile configuration.

Figure 3–22 Duplicate Tile Configuration

Banner and Contextual Area Configuration
You can configure Retail Home to display reports and metrics in the contextual report 
and banner area of the dashboard.
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Figure 3–23 Banner and Contextual Area

To configure the reports and metrics, complete the following steps:

1. From Dashboard Configuration, select Banner and Contextual Area.

2. Select a role from the Role drop-down list.

3. Select the Banner Active check box. This determines whether or not the banner is 
displayed on the dashboard. If the banner is active, you must provide a value for 
the following:

■ Select a layout from the Layout drop-down list.

■ Select a banner name from the Banner data name drop-down list.

■ Select a data source type from the Type drop-down list.

■ Enter a valid data source URL into the Source text box. The URL will be 
validated.

4. To configure the Contextual Area, select the check box to make the Primary Area 
active or the Secondary Area active. If you make both areas active, then both will 
be displayed on the dashboard. If you do not want to display the Contextual Area, 
then do no make either area active.

For whichever area(s) you have designated (Primary and/or Secondary) as active, 
provide values for the following:

■ Select a layout from the Layout drop-down list

■ Select a name for the area from the Name drop-down list.

■ Select a type (FILE or REST) from the Type drop-down list.

■ Enter a valid data source URL into the Source text box. The URL will be 
validated.
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Figure 3–24 Example Configured Banner and Contextual Area

5. Click Duplicate to duplicate the configuration to another role.

Figure 3–25 Duplicate Banner and Contextual Area Configuration

Enter the role to use for the duplicate. Click OK to save your changes and exit the 
dialog box. Click OK and Duplicate Another to repeat the process with another 
role.

6. Click Save to save your work and continue. Click Save and Close to save your 
work and close the tab.

Custom Tile State Reports Configuration
This section describes the process for creating custom tile state reports from a tile state 
report template.

To access the Custom Tile State Reports page, complete the following steps:

1. Open the Settings navigation menu.

2. Select Configuration.
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Figure 3–26 Configuration

3. Select Custom Tile State Reports, shown in Figure 3–27, which displays a table 
listing all the custom tile state reports that have been added and a toolbar that is 
used to add, edit, and delete custom tile state reports.

Figure 3–27 Custom Tile State Reports

 Adding a Custom Tile State Report
To add a custom tile state report, complete the following steps:

1. Click Add to open the Add Custom Tile State Report dialog.
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Figure 3–28 Add Custom Tile State Report

2. Select a template from the Report Template drop-down list. Note that the Report 
Parameters section of the dialog will update dynamically, depending on the 
selected template since each template defines its own set of report parameters.

3. Enter a name in the Report Name field. This name is used to identify the report in 
the Tile Configuration screen on the Dashboard Configuration page.

4. Complete the Report Parameters section. See the documentation for each Report 
Template for an explanation of the template's Report Parameter fields and 
expected values.

5. Click OK to add the custom tile state report or OK and Add Another to add the 
custom tile state report and then add another.

Configuring BI Two Metric Template
Tile state reports created from the BI Two Metric Template render the common Two 
Metric Template tile state layout with data coming from an OBIEE analysis.

Note: Retail Home must be installed with BI Integration enabled for 
this functionality to work properly.

The following tile state uses the Two Metric Template tile state layout:

Figure 3–29 Tile State Example

Each metric has a label, value, and optional description. In the above tile state 
example, the first metric's label is Daily Sales Retail, its value is 5,837K, and its 
description is USD.
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The BI Two Metric Template has the following report parameter configuration:

BI Analysis Catalog Path
The path to an analysis within OBIEE. 

The analysis path is a combination of the analysis's Location and Name, as found in 
the analysis's Properties within OBIEE. 

Example: /shared/Retail Home/Dashboard Tiles/Clearance Sales Retail Home Tile

Figure 3–30 Clearance Sales Retail Home Tile

In the above example, the analysis's Location is "/shared/Retail Home/Dashboard 
Tiles" and the analysis's Name is "Clearance Sales Retail Home Tile." The full "BI 
Analysis Catalog Path" is formed by joining the Location and Name with a "/".

The structure of the OBIEE analysis must match the documented format discussed in 
this section.

The analysis must have the following columns, in this specified order:

1. Metric 1 Label - Required label for the first metric. Displayed above the metric 
value.

2. Metric 1 Value - Required first metric value.

3. Metric 1 Format - Optional formatting code for the first metric. See discussion 
below for valid formatting values.

4. Metric 1 Desc - Optional description (e.g. currency code) to display below the first 
metric value.

5. Metric 2 Label - Required label for the second metric. Displayed above the metric 
value.

6. Metric 2 Value - Required second metric value.

7. Metric 2 Format - Optional formatting code for the second metric. See discussion 
below for valid formatting values.

8. Metric 2 Desc - Optional description (e.g. currency code) to display below the 
second metric value.
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Note that this template requires data for at least one metric and can display up to two 
metrics.

The structure of the following example analysis in OBIEE is compatible with Retail 
Home's BI Two Metric Template.

Figure 3–31 Example Analysis in OBIEE

The following table lists the supported formatting codes that Retail Home uses to 
format numeric values.

Table 3–1  Supported Formatting Codes

Code Description Format Example

N Number 1,234,567.89

S Short Number 1.2B, 3.1M, 9.95K

PC Percent 4.5%

No data source is required when adding tile state reports created with the BI Two 
Metric Template, since Retail Home can determine the data source from the 
information provided during installation; however, for more fine-grained control, 
configure a data source for each report created from the BI Two Metric Template. The 
reports use the RetailHomeBIService data source.

Editing a Custom Tile State Report
To edit a custom tile state report, complete the following steps:

1. Select the tile state report that you want to edit in the table.

2. Click Edit. You see Edit Custom Tile State Report.

Figure 3–32 Edit Custom Tile State Report

3. Make edits to the fields that you wish to change. Note that you cannot change the 
Report Template of a custom tile state report once the report has been added. You 
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must either add a new custom report tile state report or delete your existing 
custom tile state report and then add a new one. 

Deleting a Custom Tile State Report
To delete a custom tile state report, complete the following steps:

1. Select the tile state report that you want to delete in the table.

2. Click Delete in the table toolbar. You see a confirmation.

3. Click OK to delete the custom tile state report. Otherwise, click Cancel.

Adding a Custom Tile State Report to a Tile State
All custom tile state reports added on the Custom Tile State Reports page are available 
to add to a tile on the Tile Configuration screen on the Dashboard Configuration page. 
You can find each custom tile state report by looking for its Report Name that was 
entered on the Custom Tile State Reports page. 

Note that each custom report is further marked as a custom report on the Tile 
Configuration screen with the word "Custom" appended to the custom report name.

Figure 3–33 Custom Tile State Report
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